
An Inexpensive PC Based Light Board for Community 

Theaters 
  
Background  
 
Most community theaters with a stage have a light board. This typically is a 

hardware unit that can vary from the size of a standard keyboard to an entire 

desktop of equipment. The light board is connected to theater's lighting system via 

a plug-in cable, called the DMX cable. This is a standard cable that allows any light 

board to operate in any theater.  The problem is that some light boards are 

complex to setup and operate, while others don't have all the features desired. In 

addition, they are all very costly. Usually they are priced into the thousands of 

dollars. In the last few years, several vendors have introduced PC based light 

boards but these are still priced at about a thousand dollars.  
 
I came across an inexpensive PC to DMX interface unit (Velleman VM116). It is 

typically priced about $85. As an experiment, I thought it would be interesting to 

create a PC based light board based upon it. I ordered the unit, got out my old 

programming books and within a few days I was able to create a very practical PC 

based light board.  
 
Basic Setup  
 
This package needs the VM116 (available at www.sirs-e.com) , a PC running 

Windows 98SE, ME, XP, Vista or Windows 7. The PC must have an available USB 

port. Boot the PC and wait for it stabilize. Plug the VM116 into USB port. After a 

minute or so, you should get a message (first time only) that the human Interface 

device is ready for use. With Windows Vista, the message may be that the HID 

has stopped working. This is not normal but the message can be ignored. The red 

power light on the VM116 should come on. 

 

 

Plug the VM116 into the theater's DMX circuit. You may need a 3-pin to 5-pin 

DMX  plug/jack as the VM116 has a 3-pin jack but most theaters have a 5-pin plug. 

Having your own 3-pin 50 foot DMX (microphone) cable might also be handy. 
 

 
Create a folder on your PC to contain the software. Copy the software from the 

 

on-line software distribution folder 

 

to this folder. The folder on your PC will now contain at least these two files: 

 

DMXfinder.dat 
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MikeLight.dat 
 
Rename these files 
 

DMXfinder.exe 
MikeLight.exe 
 
There also may be  theater or show files ending with .txt also. Such as:  
 

Mulberry.txt 
MellonPatch.txt  
LakeMiona.txt 
TheKingAndI.txt 
BusStop.txt 
IceHouse.txt 
OcalaCivic.txt 
 
Copy these in, if you might use them. 

 
Next copy the files: 
 
FASTTime32.dll  
K8062D.dll  
K8062e.exe 
 
that are included with the VM116's CD into the same directory. You might want to 

create shortcuts on your desktop to either this folder and/or MikeLight and 

DMXfinder files. 

 
Basic Operation  
 
Start the main program by double clicking on MikeLight.exe. A screen like this 

should appear:  
 
   
  
 



 
 
On some versions of Windows you might get the message that the program can't 

find some of the .OCX libraries. Sometimes this can be solved by running the 

program as the administrator. This can be done by right clicking on the 

MikeLight.exe file and selecting run as administrator or by setting the run as 

administrator flag in properties dialog of the short cut file that points to this file. 

I have been unable to resolve why this is needed on some versions of Windows as 

the program does nothing that needs administrator privileges.  Other times, these 

Windows libraries are just plain missing. If running as administrator does not solve 

the problem, download the Package.dat file into a empty temporary folder. Change 

its name to Package.exe and run it. It should create 3 files. One being a setup.exe. 

Run this to install the missing libraries. Remove the temporary folder when done. 

When installing the libraries, you may get a message asking if you want to keep a 

newer version. The answer is always Yes. You only want to install missing libraries. 

This is a one time task, you will be able to update MikeLight.exe by just replacing 

this single file as the libraries rarely change. The MikeLight.exe included with the 

libraries may be out of date, so replace it with the latest version from the on-line 

software distribution folder. 
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Be sure to set the Master slider all the way to its uppermost position (as show) 

before starting. Use the mouse to move the various Sliders up and down. The 

various lights should come on as you move the sliders. If they do you can skip to 

the Basic Scene Setup  section of this document. If they don't, the theater has 

non standard patching. It is possible that somebody has already figured out the 

patching for this theater. So, click on the Load item from the File menu (top line), 

this should open a window to allow you to select a file name from the folder with 

the .txt files. If you are lucky, there will be a file name with the name of the 

theater. Select this file and click on Open. Now try moving the sliders up and down. 

If they now operate the lights, skip to the  Basic Scene Setup section of this 

document. If they don't or if there was no file for this theater, you are going to 

have to patch the sliders to the DMX channels.  
 
 DMX Finder Program  
 
Exit the main program by clicking on Exit from the File menu. Start the DMX 

finder program, by clicking on “DMXfinder.exe”. The screen should look like this:  
  
 

 
 
 
 

1.​ The text box indicates the current DMX channel. Each time you click on 

NextDMX (or PreviousDMX) the current DMX channel is turned off and 

the next higher (lower) channel is turned on. By clicking on these two, 

you should be able to quickly identify which DMX channel controls which 

lights. You may enter a number directly into the text box to quickly skip 

to another channel. 

2.​ I have found it useful to keep notes in a file as to which DMX channel 

controls which lights. An entry might be, for example, “DMX channel 13 

controls the left most stage light”. 

3.​ The ONdmx and  OFFdmx allow you to turn a channel on on or off 

without changing the channel. 
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4.​ The slider can be used to vary the brightness of the current lamp. 

5.​ Unchecking the “On Off with Next Previous” cause NextDMX and 

PreviousDMX to increment (or decrement) the DMX channel without 

turning the light on (or off). 

6.​ After you have identified all the lights to their DMX channel, click on 

ExitNow. 

  
Patching DMX Channels to Sliders  
 
After you identified which lights are on each DMX channel. Exit the DMXfinder 

program and start the main program by clicking on MikeLight.exe. A screen like 

this should appear:  
 
   
 
 
 
 

 
 



 
 
Notice the yellow text box near the bottom left side of the screen. This is the 

slider number. Note that the number corresponding slider  (above) is also in yellow.  
 
From the Options menu (top line) click on Edit Sliders option. In the text box just 

to the right enter the DMX channel(s) you wish to assign to that slider. In the text 

box just below the previous one, enter a comment that explains what light(s) this 

slider controls. The comment is optional but I find it helpful to remind myself what 

a slider does without having to turn on that slider during the show. 

 

For example, you might set slider 1 to control  leftmost stage light (spot 1) on DMX 

channel 101. The upper text box would have “101” and lower text box would have 

“Spot 1”. Click the “Set Slider” button. This will record a DMX channel for the 

current slider.  You can use the “⇓” and “⇑” buttons to cycle through all the sliders 

or you can click on a slider itself to quickly select that slider. Be sure to click the 

“Set Slider” button before selecting another slider to patch else your patching for 

the current slider will be lost. 

 

If you wish to assign more than DMX channel to the same slider, enter the channel 

numbers separated by commas. For example: “56, 78, 103”.  
 
After all the DMX channels have been assigned. Click the SetMaxDMX button. If 

more than one slider has been assigned to the same DMX channel an error message 

will appear. It will indicate which sliders have the same DMX channel assigned. 

Click on a conflicting slider to edit its DMX channel assignment(s). 

 

When clicking the SetMaxDMX button no longer causes an error message, click off 

the Edit Sliders item from the Options menu. Next click the Save item from the 

File menu (top line). A save file dialog will appear, create a file by the name of the 

of the theater and save it.  
 
In the future, use the Load item to select this file when in this theater.  
 
Basic Scene Setup  
 
Start the main program, if it is not already running, by clicking on MikeLight.exe. 

A screen like this should appear:  
 
   
 
 
 
 



 
 
 
 
A scene is a set of user defined setting of the various sliders. For example, a scene 

to light the left half of the stage might involve 3 to 5 sliders set at various levels.  
 
For now, set the Fade slider at its uppermost position and the check box below it 

should indicate "No Blackout on Scene Change". 

 

To make this a defined scene that you can quickly select, first select (click) on an 

unused (grayed) Scene Button, these are the numbered buttons to the right of the 

sliders. Adjust the numbered Sliders to get the desired effect on the stage. The 

Master slider, on the lower right may also be used to achieve the desired effect. 

In the text box right below the sliders you should assign a name to the scene to 

remind yourself what or where this scene is used. I usually start each name with 

the page number in the script (e.g. 07) followed by the cue within the page (e.g. 4). 

For example “07.4 Light up center stage”. I find the name helpful for both 

off-line editing and to remind myself during the show that I'm on the correct 

lighting pattern for the current scene in the production. Once the desired scene is 



achieved click the Record button. 

 

Repeat this process for all of the scenes desired using a different scene button 

each time. A grayed scene button indicates all the Sliders recorded for that scene 

are at the lowest (off) level. A white scene button indicates at least one of the 

recorded Sliders  is on. The red scene button is the current scene.  
 
Finally, click on Save from the File menu to record your scene settings into a file. 

It is suggested that the file name be the name of the show. For example, 

“You_Cant_Take_It_With_You.txt”.  
  
Basic Scene Usage  
 
After several scenes have been recorded and saved you can quickly change the 

stage lighting by just clicking on the scene button desired. 

 

SceneList 

 

By clicking the SceneList item from the Options menu (top line)  a movable and 

resizeable frame with a scrollable list of the scenes appears. The current scene's 

name is shown highlighted.  Clicking on a scene's line in this list has the same 

effect as pressing the button of the scene that has that name. This option's 

setting is saved on a per user basis within the registry. 

 

By checking the Sorted item from the Sort menu of this frame, the display of 

scene list is sorted alphabetically. For this to be useful, the scene names should be 

prefixed by the cue number and/or page number. The mapping of the scene buttons 

to scene names is not changed as this is a virtual sorting. While the sorted list is 

displayed, the F1 and F2 keys increment and decrement by order in this display.  

 

 

 

 

 



 

 

 

Scene Copy, Paste, Merge, Clear 

 

Clicking the Copy button places a copy of the live view (the settings of all the 

sliders (including the Fade, Black and Master sliders) as well as the status of the 

"[No] Blackout of Scene Change" check box and the scene name text box) into an 

internal clipboard. This might not be the values stored in the within the current 

scene's memory location. 

 

Clicking the Paste button copies the clipboard contents to the live view. Thus, to 

copy scene 23 to scene 5 the procedure would be: Click on scene button 23, click 

Copy, click scene button 5, click Paste, finally click Record. 
 
Clicking the Merge button merges the clipboard onto the live view sliders.  If the 

setting of a slider within the clipboard is greater than the setting of that slider in 

the live view, the clipboard setting of that slider is copied to the live view slider. 

The clipboard's values of the Fade, Black and Master sliders and the check box 

setting are not considered during merge. 

 

Clicking the Clear button clears the live view by setting all the sliders, the check 

box and the scene name text box to their default values 

 

Note that these 4 buttons do not use nor change the data in any scene memory 

location, they only use and change the live view. 

 



Scene Insert, Delete, Clear All 

 

Clicking Delete, deletes the data in the current scene memory location and the 

data in all higher numbered scenes is moved down one scene number. 

 

Clicking Insert, duplicates the data in the current scene memory location into the 

next higher numbered scene. The data from higher numbered scenes is moved up 

one scene number. 

 

Clicking Clear All Scenes, clears the live view then copies the live view into all the 

scene memory locations. 
 
Quick Buttons 

 

Within the options menu, the item Quick Buttons is available. This option controls 

the displaying several of the buttons on the screen. These buttons provider 

quicker access to their associated functions than going through the top menu at 

the expense of a more cluttered screen. It is the user's choice to display them or 

not. This item's setting is saved on a per user basis within the registry.  

 

 

Complex Fixtures 

 

Within the options menu, the item Complex Fixtures is available. This option allows 

control of the features on complex fixtures. These features might include control 

of gobos, aiming, zoom, and color.  When this option is set the high 16 channels 

(25-40) are not effected by the Master slider, flash button, blackout button nor 

fades between scenes. When this option is active, slider 37 (38,39, 40) should be 

mapped to be ALL of the complex fixtures' White (Red, Green, Blue) DMX 

channels (if any). Adjusting these sliders will change the color of ALL of the 

fixtures. Tip: When controlling fixtures like these with this option, start 

programming each scene with the color sliders (37, 38, 39 and 40) all the way up, if 

you start with them all the way down the color of ALL lamps will be BLACK (off) 

and no matter what you do with the intensity level sliders! The rectangular box 

below the scene name box shows the approximate color that has been selected by 

these four sliders. As the color mapping of the PC's screen and of the lamps are 

not exactly the same, there will be some differences. This item's setting is saved 

within the registry on a per user basis. 

 

Scene Fade and Black Timing  
 
When the Fade and Black sliders are in their uppermost positions, all scene 

changes take place as quickly as possible. Moving the Fade slider to a lower position 

slows the rate at which the old scene fades out and the new scene fads in. If the 



check box indicates “No Blackout on Scene Change” the fade out and fade in 

overlap each other.  
 
If the check box indicates “Blackout on Scene Change” the fade out will complete 

to blackout before the fade in begins. In this case, if the Black slider is lowered, 

there will be some noticeable period of total blackout between the fade out and 

fade in. The lower Black slider, the longer the blackout.  
 
When a scene is recorded, with the Record button, the settings of the Fade and 

Black sliders as well as this check box are recorded with the sliders into the 

scene's memory location.  
 
When changing between scenes, for example from scene 15 to scene 7, the 

settings from the old scene (15 in this case) are used to control both the fade out 

of scene 15 and the fade in of scene 7 as well as the blackout time (if any). 

 

The numbers above the Fade and Black sliders indicate the duration, in seconds, of 

the fade or blackout. 

 

Flash and Blackout/Resume 

 

Clicking on the Flash button causes all lights to turn off for as long as the mouse 

button is held down. Releasing the mouse button causes the lights to restore to 

their previous levels. Clicking on the Blackout button causes all lights to turn off. 

Clicking on the Resume button causes the lights to be restored to their previous 

levels before the Blackout button was clicked. 

 

Keyboard Function Keys 
 
The keyboard function keys F1 (for Next) and F2 (for Previous) can be used to 

step through the scenes. If the scene buttons are shown, the these keys step 

through by button number order.  

 

Solo Mode 

 

Moving the mouse over a scene button and then holding the right mouse button 

down causes that scene to be immediately applied without any fade or blackout 

times. Releasing the button restores the previous lighting pattern without any fade 

or blackout times. 

 

JoyStick (underdevelopment) 

 

Clicking on the Enable JoyStick option under the JoyStick menu, enables use of a 

joystick. This is a new feature that has not been fully developed but you are 

welcome to try it out. It may change or be deleted in futures versions. Once the is 



JoyStick is enabled the buttons on the JoyStick operate as follows: 

 

Button 1 Does the same as the F2 keyboard key. 

Button 2 Increases the Master Slider by 40%. 

Button 3 Does the same as the F1 keyboard key. 

Button 4 Decreases the Master Slider by 30% 

 

 

Independent Mode 

 

Double clicking on the number below a slider turns the number’s background red 

and puts that slider in independent mode. In the mode this slider’s value is only 

changeable manually. This is, you can only change it by selecting it with the mouse 

and moving it. Changing scenes has no effect on this slider, likewise Paste, Merge, 

Clear, Blackout, Flash and Master do not effect it. Double clicking on it again or on 

another slider’s number releases it from independent mode. 

 

Grouping Sliders 
 
Clicking on the number above a slider turns the number’s background blue and 

switches that slider in or out of the group. All sliders in the group move together. 

Thus, changing manually one slider in the group moves the rest of the group’s 

sliders to that value also. The group is very temporal, changing scenes clears the 

group, likewise Paste, Merge, Clear and Load also clear the group. 
 
Missing Features  

 

As I built this software for my own use in community theaters, I did not include 

features that either I don't use or I can't test in a local theater. Such features as 

chases, the ability to aim or focus lights through the light board are not in this 

software. Nor does this software support any interface except the VM116. A more 

feature rich free software package you might want to consider if you want these 

features is FreeStyler. One attribute that this package does have that few others 

have is the ability to run on a Windows 98SE machine with only 64MB of memory.  

Many people have one these laptops sitting around. It is too limited for most 

applications but too good to throw away. This program also displays 40 sliders and 

40 scene selection buttons on the screen at the same time. I find this a very 

helpful feature that no other program (that I'm aware of) has. 

 
Technical Quirks 

 

The signal sent to the DMX dimmer channel is a number from 0 to 255. In the first 

versions of this software a simple linear translation was used. That is, setting a 

slider to its half way point would send a signal of 128. This did not appear to dim 

http://www.freestylerdmx.be/


the light by half. So, it was changed from being linear to exponential. This makes 

the slider's position agree with the apparent light level. The actual formula used 

for the DMX level is: (slider's value)² * (master's value)² / (255)³. This might be 

refined in the future. 

 

Internally the program maintains a database of linking each scene button to a name 

and the various settings for that scene. The scene name list is a run time sorted 

mapping of scene names that link back to a scene buttons. 

 

The time duration set by the Fade and Black controls is also exponential. The 

smallest time increment was set to be greater than the maximum time the program 

needs to process 20 channel level changes. This might be refined in the future. 

 

The VM116 can become sluggish (up to 600 milliseconds) if it needs to process 

many channels. Thus, keep the maximum DMX channel number used as low as 

possible by assigning unused sliders to DMX channel 0. 

 

The program never sends a signal to DMX channel 0. No dimmer should be 

configured to channel 0. 

 

The program sends a 0 signal level to DMX channels 1 to 40 upon start up. This may 

change or become an option in the future. 

 

When this program terminates, all channels are left at their current levels. It was 

considered saving the current state program from time to time and using this 

information to quickly restore everything at start up in case of a program crash in 

during a live show. So far, the program has proved to be incredibly stable and thus 

no need for such a feature. 

 

Upon loading a .txt file, the program makes scene 0 from the file the current live 

scene. You might want to make is a default light setting. Perhaps some stage and 

house lights at about half brightness. 

 

While not recommended nor supported, it is possible to assign a DMX channel to 

more than one slider. When a scene change or master level change occurs, the 

setting of the highest numbered slider is used to control the DMX channel. When a 

single slider's level is changed, that slider's level will be used to control the DMX 

channel. This may change in future versions of this software. 

 

 

New versions of the files may be created from time to time. The documentation 

will be updated, if operational changes are made. 

 
No Warranty  

 



This software is distributed free of charge. There is no warranty that it will 

operate as documented nor that it will not cause inadvertent harm.  
 
Questions and Comments 

 

Questions and comments may be emailed to mikeveach43213@yahoo.com 
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